DIGITAL ART
DESIGN with

AND

of

ADOBE CREATIVE CLOUD

S E C O N D

E D I T I O N

XTINE BURROUGH

FOUNDATIONS OF DIGITAL ART AND DESIGN WITH ADOBE® CREATIVE CLOUD, 2nd Edition
xtine burrough

New Riders
www.peachpit.com
To report errors, please send a note to errata@peachpit.com
New Riders is an imprint of Peachpit, a division of Pearson Education.
Copyright © 2020 by xtine burrough. All Rights Reserved.
Executive Editor: Laura Norman
Development Editor: Victor Gavenda
Senior Production Editor: Tracey Croom
Copyeditor: Linda Laflamme
Indexer: James Minkin
Proofreader: Becky Winter
Cover Designers: Crystal Adams with xtine burrough and Chuti Prasertsith
Cover Illustrations: Elena Rudyk & Paladin12 from Shutterstock
Back Cover Author Photo: Chad Phillips
Interior Designer: Mimi Heft
Compositor: Kim Scott, Bumpy Design

NOTICE OF RIGHTS

This publication is protected by copyright, and permission should be obtained from the publisher
prior to any prohibited reproduction, storage in a retrieval system, or transmission in any form
or by any means, electronic, mechanical, photocopying, recording, or otherwise. For information
regarding permissions, request forms and the appropriate contacts within the Pearson Education
Global Rights & Permissions department, please visit www.pearsoned.com/permissions.

NOTICE OF LIABILITY

The information in this book is distributed on an “As Is” basis without warranty. While every
precaution has been taken in the preparation of the book, neither the author nor Peachpit shall
have any liability to any person or entity with respect to any loss or damage caused or alleged
to be caused directly or indirectly by the instructions contained in this book or by the computer
software and hardware products described in it.

TRADEMARKS

Unless otherwise indicated herein, any third party trademarks that may appear in this work
are the property of their respective owners and any references to third party trademarks, logos
or other trade dress are for demonstrative or descriptive purposes only. Such references are not
intended to imply any sponsorship, endorsement, authorization, or promotion of Pearson Education, Inc. products by the owners of such marks, or any relationship between the owner and
Pearson Education, Inc., or its affiliates, authors, licensees or distributors.
ISBN 13: 978-0-13-573235-9
ISBN 10:
0-13-573235-2

ScoutAutomatedPrintCode

For Parker and Martin, and art and design students

ACKNOWLEDGEMENTS
It has been an absolute pleasure to work with Laura Norman and her team at
Peachpit. Victor Gavenda read this manuscript more times than I did. Thank
you to Victor, Linda Laflamme, Ben Ferrini, Tracey Croom, and Cindy Teeters.
I am grateful for my colleagues in the School of Arts, Technology, and Emerging Communication (ATEC) at UT Dallas, and the support of our dean, Anne
Balsamo. A special thank you must be expressed to those students who used
this book in draft format as we worked the kinks out of exercises that appear
in each chapter. Savannah Leigh Steele reviewed nearly all of the exercises for
the first edition of this book and was a lifesaver during the writing process.
Thank you, always, to Christopher James at Lesley University College of Art
and Design for showing me how to live a life full of passion for photography
and visual communication during my undergraduate career. Steve Kurtz,
Claire Pentecost, and Humberto Ramirez showed me how to be an artist/
scholar and continued to demonstrate the critique process I learned from
James in my time at Vermont College of Fine Arts. My gratitude for such holistic teachers is lived out in my daily “professor” performance. I can only hope
to pay forward the love for life, creativity, and reflection I have learned by
being in the presence of these artist educators.
This book includes a lot of images of art works that could have resulted in a
great amount of permissions expenses. Nearly all of the images in the text
were donated. Dear artist and designer contributors, I am forever grateful for
your willingness to have your works included here. Thank you, thank you.
Finally, I have much gratitude for the ongoing support that my friends and
family provide: Laurie Cella, Emily Erickson, Sam Martin and Paco Aragon—
and Tate and Niles, Lucy HG Solomon and Matt Solomon—and Birdie and
Rosie, Sabrina Starnaman, and my mom and dad. Paul Lester, Martin Lester,
and Parker Lester, you continue to teach me in the UU tradition, with open
minds, loving hearts, and helping hands. Thank you.

CONTENTS
Introduction xi

SECTION 1:

BITS, PIXELS, VECTORS, AND DESIGN
CHAPTER 1: THE DOT, THE PATH, AND THE PIXEL

Paths and Vector Graphics 12
Pixels and Bitmap Graphics 12
Exercises
1. File Presets in Illustrator 13
2. Shapes, Fills, and Strokes 14
3. Figure and Ground with Repeated Dots 17
Screencast 1-1: The Pattern Brush 19
4. Grouping and Alignment 19
5. A Figure and Ground or “On” and “Off” Study
Lab Challenge 22
CHAPTER 2: DRAWING EXPRESSIVE LINES

•

•

9

22

23

Saving and Sharing Files 27
Exercises
1. Place and Lock an Image 29
2. Understand Layers 31
3. Create Lines with the Pencil Tool 32
4. Duplicate the Composition 34
5. Add a Gradient Background 36
6. Create Depth with Contrasting Values 38
Screencast 2-1: Add the “Swoosh” at the Horizon
7. Use Master Files and Shared Files 41
Lab Challenge 42
CHAPTER 3: MODIFY BASIC SHAPES

•

39

43

Signs and Logos 46
Vector Curves 46
Exercises
1. Create a Document with One Artboard and Set Guides 47
2. Combining Shapes 50
3. Duplicate the Artboard and Add Anchor Points 53
4. Convert Anchor Points from Straight Edges to Curves 56
Screencast 3-1: Modify Paths with the Pen and Direct Selection Tools
5. Reflect and Copy a Shape 58
6. Save a Multi-page PDF 60
Lab Challenge 61

58

Contents

v

SECTION 2:

DIGITAL PHOTOGRAPHY
CHAPTER 4: CREATING AND ORGANIZING

DIGITAL PHOTOGRAPHS •

67

Measuring Light 70
Rule of Thirds 70
Adobe Bridge 71
Exercises
1. Camera Mechanics 72
2. Camera Settings 73
3. Bracketing 78
4. Before You Shoot 79
5. Rule of Thirds 80
6. Bridge Workspaces 82
7. Batch Rename 85
Screencast 4-1: Renaming and Ranking Files in Bridge
8. Generate a PDF to Showcase Your Files 88
Lab Challenge 90
CHAPTER 5: RESOLUTION AND VALUE

•

88

91

Redistributing and Resampling Pixels via Resolution 92
Value and the Tonal Range 93
Zone System Redux 95
Exercises
1. Redistribute Pixels for Print Resolution 97
2. Resample Pixels for Screen Resolution 99
3. Analyze a Photograph Using the Zone System 101
Screencast 5-1: Use the Info Panel to Check Your Eye Against
Image Data 104
4. Modify the Tonal Range with a Levels Adjustment Layer 106
Lab Challenge 110
CHAPTER 6: COLOR MODELS

•

111

Subtractive Processes 112
Additive Processes 113
Exercises
1. Harmony in Rectangles with Adjustment Layers for Hue/Saturation 118
2. Simultaneous Contrast in Circles 123
3. Color Comparison 127
4. Color Correction with Adjustment Layers for Levels and Curves 127
Screencast 6-1: Applying Color to a Black-and-White Photograph 132
5. Color Correction in Adobe Lightroom Classic 132
Lab Challenge 135

vi FOUNDATIONS OF DIGITAL ART AND DESIGN WITH ADOBE CREATIVE CLOUD

SECTION 3:

DIGITAL MANIPULATION AND FREE FAIR USE
CHAPTER 7: REPAIRS AND HOAXES

•

145

Digital Repairs 146
Creating a Hoax 147
Exercises
1.	
Remove Dust and Heal JFK’s Blemishes with the Develop panel in
Adobe Lightroom Classic 149
2. JFK’s Eyes: Tonal Repairs with Dodge and Burn 155
Screencast 7-1: Adding and Deleting within Selections 157
3. It’s a Hoax! Adding an Extra Mummy Finger 160
4. Softening Cloned Edges 162
Lab Challenge 164
CHAPTER 8: SELECT, COPY, PASTE, COLLAGE

•

165

Precision Selecting with the Pen Tool 166
Non-destructive Editing 168
Exercises
1. Set Up the Collage Workspace 170
2. Trace an Image Contour with the Pen Tool 172
Screencast 8-1: Tracing with the Pen Tool 172
3. Modify Paths 177
4. Convert a Path to a Selection to a Layer Mask 180
5. Scale, Adjust, and Organize 183
6. Copy a Layer to an Open Document 184
7. The Magic Wand 186
8. Select, Copy, Paste, Repeat 190
Screencast 8-2: Duplicate, Transform, Burn, Organize,
and Adjust—Ants in the Hand 193
Lab Challenge 193
CHAPTER 9: PROTOTYPING EXPERIENCES FOR MOBILE

AUDIENCES •

195

Screen Resolution 198
Getting Started with XD 198
Exercises
1. Articulate the Design Challenge 199
2. Set Up Artboards 200
3. Additional Visual Design 204
4. Connect the Prototype Screen 207
5. Test and Share 211
Lab Challenge 212

Contents

vii

SECTION 4:

TYPOGRAPHY
CHAPTER 10: TYPE AND IMAGE

•

223

Contrast and Rhythm 224
Text Boxes 227
Text Adjustments: Kerning and Leading 227
Exercises
1. Define a Color Mode, then Place and Relink an Image 230
2. Add a Text Box 232
3. Resize and Kern Display Type 234
4. Replace Type with an Image 239
5. Add Vector Shapes to Frame the Composition 242
6. Final Design Adjustments 244
Screencast 10-1: Hiding Page Elements with a White Shape
or a Clipping Mask 247
Lab Challenge 247
CHAPTER 11: THE GRID

•

249

Gestalt 250
Swiss International Style 252
Sentences and Paragraphs 253
Exercises
1. Alternative Paper Sizes 258
2. Guides and the Grid 259
3. Create Your Own “Virtual Leading” Spacers
4. Using Your Virtual Leading 264
5. Placing Another Guide on the Grid 266
Screencast 11-1: Using the Grid 270
6. Use the Grid 270
7. Save a PDF with Trim Marks 272
Lab Challenge 273
CHAPTER 12: CONTINUITY

•

261

275

The Gestalt Laws of Similarity and Continuity 276
0:00:00:00 279
Reading on the Screen 280
Inspiration Everywhere, Even Right at Home 281
Exercises
1. Video Terminology and the Adobe Premiere Pro Workspace 283
Screencast 12-1: Create a New Premiere Pro Project
and Import Media 283
2. Build a Composite Sequence with Images and Sound 287
Screencast 12-2: Exporting Still Images from a Sequence in the
Timeline Panel and Import Files to a Bin 287
3. Adjusting Clips in the Timeline 290
4. Adding Effects and Sharing Attributes 293
5. Adding Type with Adobe Fonts 297

viii FOUNDATIONS OF DIGITAL ART AND DESIGN WITH ADOBE CREATIVE CLOUD

6. Working with Keyframes 299
7. Add New Tracks 302
Screencast 12-3: Modifying Keyframes
8. Your Turn! 303
9. Fade to Black and Export 305
Lab Challenge 307
CODA: REVISION PRACTICES

•

303

309

Clear, Open Communication and Accessibility 311
Pencilbox Studios: Mission Hospital 311
riCardo Crespo: Hot Wheels and Standing Meetings 317
Michael Demers: The Sky Is Falling (A Day in the Life…) 318
The League of Imaginary Scientists: In League with an Institution
Jovenville: Boardstorming 324
Conclusion 327

320

Index 328

Contents

ix

This page intentionally left blank

INTRODUCTION
WHAT ARE THE FOUNDATIONS OF
DIGITAL ART AND DESIGN?
In the School of Arts, Technology, and Emerging Communication (ATEC) at UT
Dallas, where I am teaching now, students encounter this book during their
first year of coursework. However, knowing the origin story of this book is
useful for understanding how I came to think about foundations materials for
digital art and design students who might be completing coursework in various types of schools or programs, such as art, communication, design, digital
humanities, media studies, and so on.
I originally designed this book before arriving at UT Dallas, when most of my
students had little time in their schedules for classes that would heighten their
understanding of visual communication: foundations of two-dimensional
design, typography, drawing, and so on. Instead, they enrolled in a large
historical survey course and some took an elective “skills” course, in which
they learned some Adobe applications. Mastery doesn’t happen in a mere
sixteen weeks. At best, the skills course created awareness of the concepts
and techniques that someone entering the creative professional industries
should master.
First developed to serve these students, this book is now used by readers
and educators in two-year and four-year fine arts and applied arts programs,
college-level communications and media departments, and in some U.S. high
schools. Knowing the breadth of my audience, the aim of this book is to offer
the most information at the confluence of design (principles, histories, and
theories), Adobe software, and examples of digital art for readers, educators,
and practitioners with varied interests. My goal is to be thorough enough for
university students and clear enough for high school students.
The majority of my students are interested in practicing the exercises and
mastering the software, because they’re anxious to jump in and create. Educators are interested in teaching art and design, because they’re passionate
not about software, but about media art, graphic design, animation, games,
digital video, emerging forms of digital expression, and so on.
My approach to mediating this clash of interests is to write about and show
as many ideas and examples of art and design history and principles as I can
while demonstrating the use of the tools. For example, instead of showing
students how to remove red-eye from a photograph (there are loads of videos
on YouTube for such a specific endeavor), I demonstrate making a conscious

Introduction

xi

design choice in regard to scale, proximity, the rule of thirds, or other principles while using Adobe’s tools. I’ve tried to keep the exercises short, while
also showing the fundamental tools in many of the Adobe programs. Most of
the tools have changed very little since the first time I used Photoshop in 1992
(with the major exception of the development of layers in 1994, but I digress).
In ATEC, students attend a lecture, traditional studio, and computer lab. So
this course (and this book) merges a traditional course in two-dimensional
design with foundations of digital art and design practices. I start in Section 1, Bits, Pixels, Vectors, and Design, with material that’s been presented by
the authors and artists on whose shoulders I’m crouching: Donis A. Dondis
(A Primer of Visual Literacy), Johannes Itten (Design and Form: The Basic
Course at the Bauhaus and Later), David A. Lauer and Stephen Pentak (Design
Basics), Wucius Wong (Principles of Form and Design), and others. It is this
understanding of the language of design that I consider foundational. I also
include examples of each principle or basic element drawn from contemporary works of digital art. Although this book may be assigned in a graphic
design program, it’s often read within the broader context of digital art. I have
had many roles as an educator, from an education advisor on the AIGA Orange
County board to a co-author of a trilogy of collections on remix studies—my
personal identity as a digital artist is also part of this equation.
Two-dimensional design is followed by Section 2, Digital Photography. In the
classroom, I find it easier to present basic vector graphics before introducing
the pixel-loaded arena of digital imaging—Adobe Illustrator is often a much
more forgiving application than Adobe Photoshop due to the insignificance
of file resolution at such a basic level. In this text, photography is primarily
considered to be another vehicle through which the basic elements of design
can be understood. In our program, students use this portion of the text to
learn to organize files, compose in a photographic frame, and understand
color relationships.
Because photo manipulation is nearly as old as the medium itself, the natural
follow-up to photography is Section 3, Digital Manipulation and
Fair
Use—where better to talk about contrast through juxtaposition? Collage and
photomontage are historical legacies of the digital operations: cut, copy, and
paste. While discussing these, I also bring forth contemporary strategies for
sampling and licensing with copy-left or Creative Commons licenses in this
section.
Section 4, Typography, teaches students to honor and manipulate type. This
is essential, as most visual communication comprises type and image, and
occasionally time. I studied photography in my undergraduate days at the Art
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Institute of Boston; typography is an art that I learned during my professional
life as a web designer in the 1990s and since then as a professor. It helped that
I lived with one of the best typographic educators in Southern California in
the early 2000s. I’ve talked with many educators who are strong in one area—
photography, typography, web design, or something else—but feel a deficit
in another. As such, I provide resources for additional materials throughout
the book, both for students and educators who might be using this text in
a classroom.
The Coda, at the end of the book, explains the important concept of revision.
A student may assume that she has an experiential understanding of design
principles after simply following the steps in a software application. Students
and readers must remember, however, that reading a book on learning to play
the guitar or manipulate imagery, is not the same as mastering the instrument or software. Practice, and of course revision, is the best way to learn the
craft and become more efficient. I’ve included revision stories from artists and
design professionals alike.
In addition, you’ll find one bonus section online or in the electronic version of
this book:
Automation is key to working efficiently, so one chapter in Section 5, Effective
Work Habits, (available online or in the eBook) is dedicated to it. The other
chapter addresses the question, “How do you suggest I make a portfolio I can
send someone?” There’s no one perfect answer, as each student has different
talents and different needs. But learning pagination in Adobe InDesign can
help students who want to create their own books—a handy skill for soon-tobe graduates or those applying for internships.
Lastly, I would like to offer an update of Dondis’s scale that registers the
differences (or similarities) among specific artistic media on a continuum of
“fine” and “applied” art in FIGURE I.1. To demonstrate that the Bauhaus “would
group any and all of the fine and applied arts on one central point in the
continuum” [1], Dondis placed the media of the time grouped around a central
point on the horizontal axis (FIGURE I.1).

REFERENCE [1] Donis A.
Dondis, Primer of Visual
Literacy (Cambridge, MA:
MIT Press, 1973). 4.

All forms of visual message-making are influenced and analyzed by an
understanding of the basic elements of design, on the screen, in print, as a
hologram, or however else they may come to us on future platforms. Whether
you intend to be a web designer, a social media entrepreneur, a digital installation artist, or a game developer, the design foundations offered in this book,
coupled with the exercises in each of the software applications, will help you
achieve your goals.
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Because all students or readers will have different hardware, software, and
needs, you’ll learn to use this book in the most fitting way for your setup in
the following exercises.
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EXERCISE 

1 OPERATING SYSTEMS

When the Mac was released in 1984, it included a graphical user interface
and a mouse, two visual user-oriented components that were missing from
other personal computers (FIGURE I.2). Artists and designers developed a strong
loyalty to Apple over time as their needs and concerns were often met first on
the Apple platform. For a while, there was no question about which platform was best suited to making art on the computer: Mac. Universities now
have Mac and Windows labs dedicated to art and design programs. In some
creative industries, such as graphic design or digital photography, Mac (now
rebranded macOS) is still the standard platform. However, web designers,
game developers, and animators often work on the Windows platform.
It does not matter if you use a macOS or Windows. Your files will transfer easily from one operating system to the other. (Be sure to include the file extensions in the name of your file—something you’ll learn more about in Chapter 1,
The Dot, the Path, and the Pixel). If you’re creating multimedia art or designs,
you’ll want to view the work on both platforms. However, this should not
dictate where you conceive and develop the project.

FIGURE I.2 The first Mac
computer sold commercially in 1984. It included
a mouse and a graphical
user interface instead of
the ever-intimidating
command line.

I’ve written this book using macOS. The screenshots were made on my MacBook Pro. However, every keyboard shortcut is provided in both macOS and
Windows versions. For instance, the File > Copy command shortcut is listed
throughout the book as Command-C/Ctrl-C.
That’s it. The rest is more or less the same.
EXERCISE 

2

DOWNLOADING WORK FILES, BONUS
CHAPTERS, AND VIEWING SCREENCASTS

Some of the exercises in this book will require you to download a work file or
a set of files before you begin. Readers who buy the print edition of the book
will also want to download the bonus section on Effective Work Habits. All of
the files are on the companion websites for the book at www.digitalart-design.
com (FIGURE I.3) and at peachpit.com for registered users (see “Accessing the
online content at peachpit.com” later in this chapter). I’ve also posted a link
to the work files on my personal website (www.missconceptions.net), and
there’s a Facebook page for Foundations of Digital Art and Design where I post
updates and answer reader questions [2].

REFERENCE [2]

facebook.com/
FoundationsOfDigital
ArtAndDesign
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FIGURE I.3 A screenshot of

the companion website,
www.digitalart-design.
com. You can download any
necessary work files from
this site before beginning to
work on the exercises in the
chapters.

REFERENCE [3]

bit.ly/video-demos or
bit.ly/foundations-demos
REFERENCE [4]

bit.ly/youtube-demos

Most chapters include a screencast in which I have demonstrated my process
for some part of the chapter’s exercises. These offer me an opportunity to
show a portion of the exercise that is better demonstrated in a live presentation than captured in images and text. They are also an archive of tutorial
files that my students and I rely on for use outside of the classroom. These
are accessible from the companion website. The screencasts for this second
edition of the book are published on Vimeo [3]. The screencasts for the
first edition of the book are preserved on YouTube [4].

ACCESSING THE ONLINE CONTENT
AT PEACHPIT.COM
1. Go to www.peachpit.com/register.
2. Sign in or create a new account.
3. Enter the ISBN: 9780135732359, and click Submit.
The lesson files can be accessed through the Registered Products tab on
your Account page. Click the Access Bonus Content link below the title of
your product to proceed to the download page. Click the lesson file links to
download them to your computer.
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EXERCISE 

3 THIRD-PARTY IMAGES

Many of the images in this book were donated by artists and designers.
Some were available for me to use in a commercial publication because
the copyright had expired or because the work was part of a government
archive, which usually puts it into the public domain. To those who donated:
Thank you!
You’ll learn more about public domain, the copyleft movement and creative
licensing techniques in the introduction to Section 3, Digital Manipulation and
Fair Use.
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CHAPTER 7

REPAIRS AND HOAXES
THE EXERCISES IN this chapter will provide technical lessons using
Adobe Photoshop and Adobe Lightroom Classic and teach you to
match textures and values to create photographic illusions in two
compositions. You’ll explore various tools for healing and cloning
parts of an image, as well as add a simple layer mask to blend image
features for a quality of verisimilitude.

145

DIGITAL REPAIRS
LINK For more informa-

tion on the repair tools in
Photoshop, see the Adobe
Photoshop help page: helpx.
adobe.com/photoshop/
using/retouching-repairingimages.html.

HEALING BRUSH This

tool is essentially a
combination of the Spot
Healing Brush tool and
the Clone Stamp tool: It
lets you sample a source
and tries to even out
adjacent tones and blemishes based on nearby
pixel information.

REFERENCE [1]

See nppa.org/code-ethics.

You can see both images
of O. J. Simpson on the
cover of the two magazines side by side in the
entry “O. J. Simpson
murder case” on
Wikipedia.

The repair tools are stacked in a series in the Photoshop Tools panel, starting
with the Spot Healing Brush tool beneath the Eye Dropper tool. The tools I
use most often to make repairs are the Spot Healing Brush tool and the Clone
Stamp tool. The Patch tool can be hard to control or predict, and the Red Eye
tool does what you think it does. (It’s certainly useful.)
The Spot Healing Brush tool functions as a fix-it paintbrush. You simply click
any part of the image, and the brush attempts to repair (or correct uneven
tones in) the area based on a sample of nearby pixels. Of course, it’s never a
good idea to modify your original image. So when using these tools, I recommend copying the background layer to preserve the original file. You’ll learn
more about non-destructive editing in Chapter 8, Select, Copy, Paste, Collage.
The Clone Stamp tool is also a brush. Cloning is a two-step operation: Photo
shop needs to understand what you’re cloning and where the clone should
be applied. So you’ll need to sample an original source (the what part of the
question) and then brush the sample into a new location (the where part). The
sampling part of the Clone Stamp operation can sometimes be tricky to learn,
but once you master the tool you’ll be able to repair just about anything.
Before Photoshop, artists manipulated images during the photo shoot, in the
darkroom, or on the print, for instance, with SpotTone, a specialty ink used
to correct or fill in white areas of photographs for dust spots. This seems like
a lost art now that basic photo repairs can be made so quickly using software.
However, manipulating photographic imagery has ethical implications for
photojournalists and media contributors in the digital age. For instance, the
National Press Photographers Association (NPPA) Code of Ethics includes the
following statement:
“Editing should maintain the integrity of the photographic images’ content
and context. Do not manipulate images or add or alter sound in any way that
can mislead viewers or misrepresent subjects” [1].
Instances of photo manipulation to “get a better shot” have led to firings (for
instance, Bryan Patrick from the Sacramento Bee) and loss of credibility (the
infamous National Geographic cover of the Egyptian pyramids in 1982 where
a horizontal image was smooshed into a vertical cover space). They’ve also
led to increased criticism within the field. Take a look at two shots of O. J.
Simpson published in June 1994 by Newsweek and Time magazines: the Time
photograph was manipulated to make Simpson’s skin appear darker than it
actually is.
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WHAT IS ETHICAL IN REGARDS TO DIGITAL MANIPULATION?
In the “Changes to Photographs” section of the NPPA Special Report: Ethics in the Age
of Digital Photography, Rev. Don Doll, S.J. is credited for the following ideas: “There
are technical changes that deal only with the aspects of photography that make the
photo more readable, such as a little dodging and burning, global color correction,
and contrast control. These are all part of the grammar of photography, just as there
is a grammar associated with words (sentence structure, capital letters, paragraphs)
that make it possible to read a story, so there is a grammar of photography that
allows us to read a photograph. These changes (like their darkroom counterparts)
are neither ethical nor unethical—they are merely technical.” (See www.nppa.org/
node/5127 for more information.)

CREATING A HOAX
Although visual reporters need to handle digital manipulations with caution
and care, artists often use these tools to create commentary on popular media
and historic subject matter. For instance, Josh Azzarella’s still and video
works use manipulation to revise historic events by way of deletion. In his still
image, Untitled #15 (Tank Man), Azzarella re-creates the scene from Tiananmen Square, originally photographed by Associated Press photographer Jeff
Widener. In Widener’s image, the man is face-to-face with several Type 59
REFERENCE [2] See Josh
tanks during the Tiananmen Square protests of 1989. However, in Azzarella’s
Azzarella’s videos on his
image, the tanks are removed, and the man is left isolated in the middle of the website: www.joshazzarella.
street, seemingly out of the way of danger (FIGURE 7.1). Similarly, Untitled #7
com.
(16mm) is an 11-second loop showing
President John F. Kennedy driving near the grassy knoll but never
experiencing the fatal bullet wound.
The footage of JFK riding in the car is
haunting for contemporary viewers
who know where the drive leads,
even though it never quite gets there
[2]. These examples of revision and
manipulation aren’t meant to hoax
or deceive the viewer (after all, we
know what the artist is up to), but
the strategies for image manipulation are the same as those used to
create a photographic hoax, which
FIGURE 7.1 Josh Azzarella, Untitled #15 (Tank Man). This image is a single
frame
in Azzarella’s video. Image appears courtesy of the artist.
you’ll do in Exercises 4 and 5.

Chapter 7: Repairs and Hoaxes
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FIGURE 7.2 A portrait of President John F. Kennedy before and after digital repairs.

WHAT YOU’LL NEED
Download the following source materials to complete the exercises in this chapter:
✔✔ The chapter07-workfiles.zip file which includes
repair-start.psd and hoax-start.psd in the
chapter07-start folder.
✔✔ Alternatively, you can download the two
photographs you’ll need for this chapter from
their source repositories online (see the sidebar
Downloads). Save them in a folder named
chapter07.
You’ll benefit from the ability to see changes in
values and textures across all areas of the image.

WHAT YOU’LL MAKE
In the exercises in this chapter, you’ll repair
a dusty portrait of JFK (FIGURE 7.2) and create
an “extra finger” mummy hoax (FIGURE 7.3). The
repairs and hoax share the aesthetic quality of
verisimilitude—they deceive the viewer into believing your manipulated version of reality.

FIGURE 7.3 A mummy hoax includes an extra finger.

Image credits for the source photographs President John F. Kennedy, head-and-shoulders portrait, facing front (1961) appears
and is used in this chapter courtesy of the Library of Congress [LC-USZ62-117124]. Hand of Guanajuato Mummy appears and is
used in this chapter courtesy of Tomás Castelazo.
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PUBLIC DOMAIN AND CREATIVE COMMONS LICENSED IMAGES
To begin the exercises in this chapter, you’ll use two images that are, for different reasons, free to you. The portrait
of JFK has two listings that let me judge that the image is in the public domain:
• Rights Advisory: No known restrictions on publication.
• Notes: U.S. Navy photo.
Because there are no known restrictions and this was a U.S. Navy photo (and government media is typically in the
public domain), I have assessed that the image is fair to use. Also notice that the Library of Congress includes the
following in red letters: “Rights assessment is your responsibility.”
The mummy image is licensed under the Creative Commons Attribution-Share Alike 2.5 Generic license. Because
the image has a Share-Alike component (and this book is not licensed with a CC-BY-SA license, as it would be written in shorthand), I contacted the author for permission to use the image.

DOWNLOADS: HIGH-RESOLUTION IMAGES FROM THE LIBRARY
OF CONGRESS WEBSITE AND WIKIMEDIA COMMONS
1. The photograph of President John F. Kennedy is available on the Library of Congress website—search for image LC-DIG-ppmsca-38698 on loc.gov. Beneath the
thumbnail of the image on the left side of the page, you’ll see a link to download
the 32.1 MB TIFF file of the image. This is the largest image available, and it’s the
one you should download, because you can always scale down but you can’t add
pixels. 32 MB is a large black-and-white file! It’s approximately 17 by 21 inches at
300 DPI. I downloaded this image and then scaled it down to 9 inches vertically at
300 DPI for the repair-start.psd file that I’ve included in the files on the companion site. If you want your brush sizes to match mine during the exercises, do the
same or use the files on the companion site.
2. The file Placid death.jpg is available from Wikimedia Commons. The highest
resolution file can be downloaded by clicking the “Original file” link that appears
beneath the image on the file page. If you click the image itself to open it in a
separate window, you’ll view the largest image. Then you can right-click the
image (Control-click on older Macs) to open a contextual menu from which you
choose Save Image As to download the image. Download the original file and save
it as hoax-start.jpg.

EXERCISE

REMOVE DUST AND HEAL JFK’S

1 BLEMISHES WITH THE DEVELOP PANEL

IN ADOBE LIGHTROOM CLASSIC

There are multiple ways to repair skin tones with digital tools. In this exercise,
you will use the Spot Removal tool in Lightroom Classic. In Exercise 2, you will
use similar tools in Photoshop.
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See Chapter 6 Exercise 5
to learn about importing
images to Lightroom
Classic.

1. Launch Adobe Lightroom Classic, and import the repair-start.psd file to
your Lightroom library. Make sure the Add option is active before you click
the Import button.
2. Double-click the image preview, and change the module from Library to
Develop by clicking the Develop button in the Module Picker at the top of
the screen (FIGURE 7.4).
3. The tonal range and contrast in this photograph do not appear to need
significant adjustments, however digital artists often touch-up portraits
to soften wrinkles, even skin tones, and remove blemishes. Zoom in on
JFK’s face either with the mouse wheel (or touchpad) or by pressing the
Command-+/Ctrl-+ keys. Inspect the surface of the skin, looking for places
where wrinkles appear to be especially deep as a result of shadow/highlight contrast. Also look for spots or blemishes. Load the Spot Removal tool
from the set of buttons beneath the Histogram (FIGURE 7.5).

FIGURE 7.4 Open the

r epair-start.psd file in the
Adobe Lightroom Classic
Develop module.

FIGURE 7.5 Load the Spot

Removal tool in Lightroom
Classic.
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4. Notice the Brush options that appear beneath the Spot Removal tool when
this tool is loaded. This tool operates like a brush: It has controls for its
size, feather (that is, edge sharpness), and opacity. You can work with this
tool in Clone or Heal mode. If you are cloning, you need to sample a source
to clone from before you begin brushing with the tool. If you are healing,
simply click with the brush and Lightroom Classic will work its magic
by automatically selecting a source based on a similar area of the image
according to its tone and texture. Be sure that Heal mode is selected as you
will work with the brush in this mode in the next steps (FIGURE 7.6).
5. Practice zooming in and out and moving the image around in the application window. I use hot keys for all of this, as when I use my trackpad
or mouse wheel (or a touchpad), I often end up resizing the brush by
accident. I use Command-+ and Command-– to zoom (Ctrl-+ and Ctrl-– for
Windows users), and I press the Spacebar to engage the Hand tool, which
I use to move the surface of the image around. When I am repairing or
modifying the image data, like you are about to do in this step, I like to
see that information in detail, which means that less of the image appears
on screen at once. You will quickly develop kinetic memory in your hands
to change the zoom level and location of the image on the screen without
having to look down. While the image of JFK’s face fills the screen from his
forehead to his lips, look for a dark spot on his cheekbone (his left, your
right side). Move the Spot Removal tool so the brush hovers over this area.
Is the brush too small, too large, or just the right size for repairing this
dark spot? The circular brush tip should be just a little larger than the spot.
Mine happened to be exactly the same size as the spot, so I increased my
brush by about 15 pixels. I did not use the Size slider in the Brush panel,
instead I used the key commands. Press the Left Bracket ([) key to decrease
the size of the brush and the Right Bracket (]) key to increase its size. When
the brush size is set correctly, click the dark spot (FIGURE 7.7).

FIGURE 7.6 Set the Spot

Removal brush to Heal.
HAND TOOL Use the
Hand tool to move the
image around the screen
while you’re zoomed in.
You’re not moving any
part of the image file;
you’re simply changing
your view when you use
the Hand tool. Access
this tool by pressing the
spacebar. This tool is
useful in many Adobe
applications, including
Lightroom Classic, Photoshop, and Illustrator.

ZOOM TOOL You can
easily access the Zoom
tool while working
with most other Adobe
Creative Cloud applications by pressing the
Command/Ctrl keys with
the Equal or Minus key. (I
always think of zooming
in as Command-+ even
though the Shift key is
not involved).

FIGURE 7.7 Click the Spot Removal tool on a dark spot or blemish to replace it with similar tones selected from another part of

the image. Use a brush size that covers the spot.
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FIGURE 7.8 When the brush is too large (above) or too small (top

right), your image edits will draw more attention to the spots you
are trying to hide. When the brush is the right size (right), you
should consider adjusting the feather and opacity until the new
image information fools the eye.

6. Did the spot disappear? Are you happy with the tonal adjustments
Lightroom Classic, selected for you? You can still edit this spot because
Lightroom edits are non-destructive. All of the information in the original
image is preserved, and modifications made in the Develop panel are
saved separately. In addition to your repair, you should see two circles connected by a thin arrow on top of the image. One circle shows the location
Lightroom chose to sample repair information for the dark spot. The arrow
grows from this circle to another one. At the end of the arrowhead is the
second circle, where you made the repair. Notice how the Spot Removal
tool’s appearance changes depending on where you place the pointer on
the image. When you hover the tool over either of the circles, it changes to
a hand pointer. In all other parts of the image, the circular brush remains
active for the tool, so you can repair or remove additional spots. Click the
circle over the dark spot you just removed. Modify the brush settings; they
are still active, even after you used them. Change the Size, Feather, and
Opacity settings by dragging the sliders all the way to the left and right
extremes, just to see how these adjustments control the results of your
repair, and then use your best judgment to set them properly. I ended up
leaving my settings as seen in the third part of FIGURE 7.8.
7. You can also move the circle that accounts for the sampled part of the
image to see different results from the Spot Removal tool. Use the Spot
Removal tool, again with the brush set to Heal to drag a line over the
darker wrinkle across the middle of JFK’s forehead (FIGURE 7.9). You’ll
modify the results in the next step.
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FIGURE 7.9 The Spot

Removal tool can be drawn
in a line over large areas
for repair. Be extra attentive
to the Opacity and Feather
settings in these cases.

FIGURE 7.10 The location of the sample source can be adjusted once you have made a repair.

8. Wrinkles should not be completely erased. If your Opacity was set to 100
you will have replaced them with smoother skin and you should adjust the
opacity downwards. If your brush was too large, you may have sampled
the other wrinkles across his forehead, which could have left you in a bit
of a mess. Now you should modify the brush options while the area you
just painted across is active. (If you deselected it, click the circle attached
to the area where you made an adjustment.) I changed the Opacity value
to 40, then I moved the sample source to a lower part of the forehead by
dragging the circle at the blunt end of the arrow (FIGURE 7.10).
FEATHER You will find a numeric field or slider to control the Feather value in various
parts of such Creative Cloud applications as Lightroom Classic and Photoshop. In all
cases, this refers to how sharp an edge should appear. When you are using the Spot
Removal in combination with Heal mode or the Healing Brush in Photoshop, you will
probably choose a small number for the Feather option because you do not want the
brush edges to be visible. When you are cloning, however, you may want to start with no
amount of feathering so that you clone pixel information precisely. Then you may return
to the clone area with some amount of feather applied to the brush to blend the results.
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FIGURE 7.11 When the Tool Overlay option is set to Always, it is

FIGURE 7.12 Changing the Tool Overlay option to Never allows

easy to see all of the locations where repairs have been made.

you to see results of the repairs you made without being distracted by the interface.

FIGURE 7.13 Finish your

repairs, and click the Done
button.

TOOL OVERLAY In the
Toolbar at the bottom
of the image is the Tool
Overlay menu. This lets
you control the visibility
of tools, depending on
what you are working on.
If you leave it on Always,
you will always be able
to see the circles created
by the Spot Removal
tool. This can be helpful for being able to
select them and modify
them. At other times,
you may want to change
the menu to Selected or
Never, because it can be
difficult to see the results
of the tool in the context
of surrounding pixels
when a white trace line
interrupts your view.

9. Continue working with the Spot Removal tool set to Heal on the entire
image, including the dust in the negative space around JFK’s head and the
bags beneath his eyes. Choose the Tool Overlay option Always to see all
of the locations where you have modified the image (FIGURE 7.11); choose
Never to see the results of your work (FIGURE 7.12).
10. When you are finished, click the Done button in the lower-right side of the
image window (FIGURE 7.13).
11. Choose File > Export to save a file with all of your adjustments. In the
Export One File dialog box, choose Export To: Hard Drive from the first
menu. In the Export Location section of the dialog box, choose Same
Folder As Original Photo from the Export To: menu, and in the File Naming section, choose Filename-Sequence from the Rename To: menu. You
should see a preview of the file name, repair-start-1.jpg (FIGURE 7.14). Click
the Export button.
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FIGURE 7.14 Export the file

containing image repairs to
the same folder as the original folder with a sequence
number.

12. Quit Lightroom Classic as you will work in Photoshop next.
EXERCISE

2

JFK’S EYES: TONAL REPAIRS
WITH DODGE AND BURN

Now you’ll focus on repairing the eye area. Because you’ve already done a
once-over with the Spot Healing Brush tool for dust, scratches, and major
blemish repairs, you’ll do this additional, localized work on a new layer in
Adobe Photoshop. In this exercise, you’ll modify a copy of JFK’s eyes with
the Dodge and Burn tools. If you’ve never printed a negative in the darkroom,
the analogy between this tool and common darkroom practices might not be
intuitive. Dodging reduces the amount of light a print is exposed to during
image processing in a darkroom, while burning adds additional exposure time
(remember that the more light that hits a patch of photographic paper, the
darker it becomes). Sometimes a negative needs a full exposure in all areas
except for one (for instance, around JFK’s eyes—beneath his eyes he had dark
rings and his eyebrows are so light they barely register). Photographers dodge
prints during the image processing by blocking exposure light on a certain
area (or areas) of the paper (to keep them lighter) or by blocking nearly the
entire exposure with the exception of a small area in order to “burn” it in (and
darken it). In turn, these small portions of the print receive less or more light
in comparison to the rest of the projected imagery. When burning an area of
the sensitized paper during an exposure to light in a black-and-white wet lab,
for instance, a common exposure time for the adjustment might be about 5 to
10 percent of the total exposure. So, in Photoshop, you might start with the
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WORKSPACE Choose
Window > Workspace >
Photography for the
remaining exercises in
Photoshop.

FIGURE 7.15 The Lasso tool

is grouped with other selection tools.

KEYBOARD SHORTCUTS

When copying and pasting from one layer to
another, an alternative to
Command-C/Ctrl-C and
Command-V/Ctrl-V is to
use the single command
Command-J/Ctrl-J to
“float” the selected area to
a new layer.

Exposure value set at 5% or 10% in the Burn tool options. Of course, this value
varies from negative to negative (or file to file), so it’s common to make a best
guess when using this tool in combination with Command-Z/Ctrl-Z.
1. In Adobe Photoshop, open repair-start-1.jpg, which you just exported from
Lightroom Classic. If you skipped this first exercise, open repair-start-1.jpg
from the chapter07-start folder in chapter07-workfiles.zip available on the
companion website.
2. Select the Lasso tool from the Tools panel (FIGURE 7.15). This tool lets you
make a free-form selection around any part of the image. It’s not a good
tool to use when you need to perform a precise selection, but it’s perfect
for quickly isolating a general area of the image.
3. Draw a loose circle all the way around the left eye area, including a bit
above the eyebrows. Be sure to begin and end the selection at the same
point so that Photoshop knows the complete area of the selection. You’ll
see flickering dashed lines surrounding the selected area, often referred
to as “marching ants.” Now you’ll add a selected area around the right
eye to the current selection. Press and hold the Shift key while drawing a
circular shape around the right eye area with the Lasso tool—the tiny plus
sign near the bottom of the tool shows that you’re adding to the current
selection. You should have two sets of marching ants on the image, one
surrounding each eye (FIGURE 7.16).
4. Copy the selected eye area and paste it using the keyboard shortcuts
Command-C/Ctrl-C then Command-V/Ctrl-V. In the Layers panel, rename
the new layer eyes. Choose File > Save As to save the PSD file to your hard
drive. I named mine repair-end.psd and put it in my results folder.

FIGURE 7.16 Start and end

the selection with the Lasso
tool at the same location
in the image. Press and
hold the Shift key to add
to an active selection. The
“marching ants” show a
selection around the eye
area.
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SCREENCAST 7-1 ADDING AND DELETING WITHIN SELECTIONS
You can add to any selection using one of the Photoshop selection tools by pressing the Shift key. If you want to add extra area to an existing selection, you’ll have
to begin the “new” part of the selected area from within the existing selection. If you
want to subtract part of an existing selection, press and hold the Option/Alt key while
starting the “deleted” area of the selection from outside the existing selection. This is
much more easily understood by seeing it demonstrated than by reading text. For a
demonstration, view the screencast for this chapter.

Keep a copy of the
original file in the Layers
panel when working on
repairs. Naming your
layers as you work will
keep the panel organized
and help you work efficiently as the size of the
list increases.

All screencasts are available on the companion website, www.digitalart-design.com or on
the Vimeo playlist, bit.ly/foundations-demos.

5. The bags beneath his eyes were too dark before you lightened them with
the Spot Removal tool in Lightroom Classic. In opposition to this, his eyebrows (especially his left brow) are so light they barely register. Because
you already corrected for the skin tones under his eyes in Lightroom, load
the Burn tool to darken the brows (FIGURE 7.17).
6. Glance at the Layers panel. Nothing should have changed there; you
should be working on the eyes layer. (Click it to make it active if you
noticed that another layer is active.) Always look at the tool options, especially before using a new tool. There are many options for the Burn tool.
For now, notice the Brush Preset picker menu, the Range menu (choose
Highlights), and Exposure control (set that to 10%). There are other
options, too, including the option to enable airbrush style build-up, the
Protect Tones checkbox, and an icon that allows the pressure to determine
brush size when using a stylus pen. Open the Brush Preset picker menu,
and make sure that the Hardness level is set to zero, as you’ll want your
brush to have a soft edge to allow the burning results to feather or blend
into the image. Place your pointer over the eyebrow and use key commands to adjust its size so it covers the eyebrows where they are largest
(Left Bracket key or Right Bracket key, just like in Lightroom). Now you
need to estimate a reasonable exposure value. The general rule is that you
can always brush these tools over an area more than once, so it’s better
to err on the side of a lower value. Play with the exposure value (I ended
up using 10%), and make a quick brushstroke over JFK’s left eyebrow
to darken it (FIGURE 7.18). Zoom out to 100% to evaluate your results. I
brushed twice over the left brow and once towards the end of the brow on
the right side of the image. The modification should not be extreme. Your
modification should be believable!

FIGURE 7.17 The Burn tool

is grouped with the Dodge
and Sponge tools. These
tools alter the tonal values
and intensity of the hue in
an image.

POINTER IMAGE If
you don’t see a circle
representing the size of
the brush in Photoshop,
check your Photoshop
preferences. The brush’s
appearance is set in
Photoshop > Preferences > Cursors/Edit >
Preferences > Cursors.
Choose Normal Brush
Tip. Also, make sure
your Caps Lock key is
not depressed. Engaging
Caps Lock will change
the pointer image to a
cross-hair.
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FIGURE 7.18 Touch up the

brow area with the Burn
tool. Adjust your settings so
you need to brush over this
area of the image only once
or twice.

Why not use the Spot
Healing Brush tool here?
You could work with the
Spot Healing Brush tool
to correct the eyebrows,
but the trouble here is
not the pixel information, just the value of the
highlight tone. In this
situation, correcting the
tones by burning and
dodging will maintain
the integrity of the image.

COPYING IMAGE PARTS
Be extra attentive to the Layers panel when copying selected parts of an image. It’s
common for new users to attempt to copy part of the image that they can see, but
that isn’t actually on the selected layer. If you do this, you might get an error message
stating “Could not complete the copy command because the selected area is empty.”
This happens to everyone at some point during image manipulations. Simply click OK
to exit the warning dialog, and then activate the appropriate layer before attempting
to copy again.

HISTORY IS FULL OF REVISIONS
Repairs will inevitably lead you to over-click with tools such as the Healing Brush or the Dodge and Burn tools
in the Photoshop file. It’s easy to become click-crazy in the process. Familiarize yourself with the History panel,
as you’ll come to rely on this handy Photoshop archive. There are three things you need to know about using the
History panel:
• Access the History panel from Windows > History or the History icon in the column of panels on the right side
of the Application window.
• By default, Photoshop may save only 20 or 50 of your previous clicks or steps. You’ll want to increase this when
doing repair work. Choose Photoshop > Preferences > Performance/Edit > Preferences > Performance. On the
right side of the dialog box, enter 99 in the History States field. The more clicks or previous states you save, the
more RAM you’ll use. If your computer is slow or lacking RAM, you may want to skip this step.
• To go back a step or two, or five, click once on the name of each of the previous steps in the History panel until
your file appears in the state at which you want to begin working anew. There’s nothing else you need to click.
Simply begin working again, and the History panel will create new steps, overwriting the dimmed step or steps
that you’re leaving out of your process.
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7. Review your modifications at actual size by using the keyboard shortcut Command-1/Ctrl-1. Click the eyeball icon next to the eyes layer in
the Layers panel to hide and show the layer (FIGURE 7.19). If you have
gone too far, you can reverse your way back through your actions using
Command‑Z/Ctrl-Z or the History panel (see the sidebar). When you are
finished adjusting the eye area, save your work and close the file.
FIGURE 7.19 Making the

eyes layer alternately
invisible (top) and visible
(bottom) helps preview
repairs. You can easily see
your repairs by clicking
the Eyeball icon on and off
in the Layers panel.
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EXERCISE

3

I T’S A HOAX! ADDING AN EXTRA
MUMMY FINGER

In this exercise, you’ll add an extra mummy finger using the Clone Stamp tool.
This tool functions similarly to the Spot Repair tool in Lightroom Classic and
the Healing Brush tool in Photoshop, but you’re responsible for selecting the
location of the source area before making repairs. You’ll work with a hardedged and soft-edged brush in this exercise. In the next exercise, you’ll clean
your work with a layer mask.
1. Open hoax-start.psd in Photoshop. Continue to work in the Photography
workspace.
2. In the Layers panel, click the Create A New Layer icon. Unless you clicked
the icon more than once, the layer’s default name is Layer 1. Rename
it finger. You now have an empty layer named finger above the locked
Background layer in the Layers panel.
3. Select the Clone Stamp tool from the Tools panel (FIGURE 7.20). View the
Options bar. I set my brush to 250 pixels and changed the Hardness value
to 85%. Because you’ll be copying pixels with this tool, you’ll want to use
a brush that isn’t too soft. The soft edges often blur the pixel information,
which you want to keep sharp, at least during the copying portion of this
process. Keep the Mode set to Normal, leave the Opacity and Flow at 100%,
check the Aligned box, and set the Sample menu to All Layers (FIGURE 7.21).
Remember, you’ll first sample with this tool and then clone. If you check
the Align box, you’re telling Photoshop to keep the sample area aligned
with the cloning area. You’ll see that it makes sense to keep the source and
clone aligned.

FIGURE 7.20 The Clone

Stamp tool is grouped with
the Pattern Stamp tool in
the Tools panel.
FIGURE 7.21 Brush settings are in the Options bar. The brush hardness is set to 85%. You can

also see the other tool options set for cloning in this exercise.
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FIGURE 7.22 Sample from

the mummy’s knuckle with
the Clone Stamp tool. Check
to make sure the finger
layer is active.

4. Zoom in using the same key commands as in other Adobe
applications, such as Command-+/Ctrl-+. Make sure the
finger layer is active; this is where you want to place your
cloned finger. Place the Clone Stamp tool (which basically
functions as a brush with an extra sampling step) on top
of the last knuckle. Press the Option/Alt key, and click just
once in this location (FIGURE 7.22). Don’t drag the mouse.
You just told Photoshop that this is the area that you want
to sample as you clone the new finger, and because the
option for Sample is set to All Layers, you are allowed to
sample from whatever parts of the image this brush covers,
on any of the layers. There is nothing to sample on the
finger layer, so the Clone Stamp tool will sample from the
mummy finger on the Background layer.

FIGURE 7.23 Paint a new finger using the Clone

Stamp tool aligned next to the sampled finger.

5. Move the mouse to the right of the last knuckle and down
a little bit to align it with a plausible location for a new
knuckle (FIGURE 7.23). The Clone Stamp tool provides a
preview of what the cloned image will look like in your
composition so you can get the alignment just right before
committing to a click. Click and drag downward, tracing the finger, until you reach the end of the fingernail
(FIGURE 7.24). Save the file as hoax-end.psd, which you’ll
update at the end of the next exercise.
Congratulations! You just added a sixth finger to a
mummy. In the next exercise, you’ll clean the cloned image
data to make the new finger blend with the rest of the
composition.

FIGURE 7.24 The new finger in position. The

brush hardness ensures that pixels are sampled accurately.
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EXERCISE

4 SOFTENING CLONED EDGES

KEYBOARD SHORTCUT

Because you’ll always
work with white and
black on Photoshop
layer masks, you should
remember that X is the
hot key for swapping the
foreground and background colors.

FIGURE 7.25 While the finger
layer is active, click the Add
Layer Mask icon to create a
mask specific to this layer.

Fingers don’t stay the same size from the knuckle to the nail, so because
there are extra parts of the cloned finger that obstruct the view of the original
composition, the viewer can tell that the image has been manipulated. In this
exercise, you’ll use a layer mask to hide extra parts surrounding the cloned
finger. Consider this exercise to be a brief introduction to the layer mask. You’ll
learn more about layer masks in the next chapter.
1. In the Layers panel, activate the finger layer and then click the Add Layer
Mask button (FIGURE 7.25). You’ll see a new icon in the Layers panel: a white
square next to the layer icon of the finger.
2. The layer mask is used to hide or show parts of a
layer. Because the finger layer contains only the
extra, cloned finger, the mask will affect only this
image data. You could work with the Eraser tool
to delete image data, but instead it is preferable
to work non-destructively, to simply hide (rather
than delete) pixels. Layer masks operate in white
(show the layer content), black (hide the layer
content), and shades of gray (partially hidden).
Press B to select the Brush tool (or locate it nested
with the Pencil tool in the Tools panel), and press
X to load black into the foreground color chip
(FIGURE 7.26).
3. View the Brush tool options. Set the Hardness
value to 0, as you’ll want to use a soft-edged
brush. Leave the Mode set to Normal and Opacity
and Flow at 100%. You will adjust the size using
the keyboard.

FIGURE 7.26 The Brush

4. Before using the Brush tool, make sure that the
tool is selected with black
loaded into the foremask is active in the Layers panel. You can click
ground color chip.
once on the layer content thumbnail or on the
mask icon. Notice that whichever is activated is
framed with white edges around its icon and near the file name (at the top
of the document window) additional information confirms your location
in the file’s organizational structure (FIGURE 7.27). When you’re sure that
the mask is active, you are ready to set the size of the brush and then paint
black around the edges of the finger where you want to hide the extra
image details (FIGURE 7.28).
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FIGURE 7.27 Click the layer content icon or the layer mask icon to make adjustments to the layer or its mask. Notice how the

information near the name of the file updates depending on which part of the file is activated.

FIGURE 7.28 Extra image details are hidden by painting the mask black in those areas. Here you can see the black brushstroke

on the layer mask icon.

5. Notice that the layer mask now contains an abstract black painting on its
white background. Option-click/Alt-click the layer mask icon in the Layers
panel to show just the mask in your composition (FIGURE 7.29). The black
areas of the composition are hidden. The white areas are revealed. Look
for gaps between the black and white areas. You may want to review those
parts of the composition and add more black or white paint to fill in the
gaps. This is an easy way to clean the mask because you can easily see
how the image details are being treated. Option-click/Alt-click the mask
icon in the Layers panel again to resume the normal working mode and
continue to modify the layer mask (FIGURE 7.30).
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FIGURE 7.29 A view of the

finger layer mask. The white
areas are visible in the
document. The black areas
are hidden from view (or
masked). Any gaps would
be filled in with the Brush
tool using black.

FIGURE 7.30 The mummy

finger hoax is complete and
visible in normal editing
mode.

6. Remember to view the document at actual size and then save the file.

LAB CHALLENGE
Create a hoax! Modify a current news story by using the repair and clone tools
you learned about in this chapter on a fictitious news image. In news photography, the caption is important, too. Don’t forget to write a caption to accompany your newsworthy image.
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Adams, Ansel, 65, 66, 95, 103
Add Anchor Point tool, 178
additive processes, 113–117
Ades, Dawn, 138
adjustment layers
Black & White, 192
Curves, 129–131
explanation of, 118
Hue/Saturation, 118–122, 183, 184
Levels, 108–109, 128–129, 130
Adobe Bridge. See Bridge
Adobe Capture app, 135
Adobe Fonts, 259, 260, 297–299
Adobe Illustrator. See Illustrator
Adobe InDesign, 222, 227
Adobe Lightroom Classic. See
Lightroom Classic
Adobe Photoshop. See Photoshop
Adobe Premiere Pro. See
Premiere Pro
Adobe XD, 198
artboard setup in, 200–202
creating connections in, 207–210
designing prototype screens
in, 204–206
testing and sharing prototypes
in, 211
Airey, David, 46
Albers, Josef, 116, 117, 121
Align buttons, 49
Align panel, 20, 21
Align to Selection option, 49
aligning
dots, 19–20
shapes, 49
type, 254–255
anchor points, 12, 16
adding, 56, 166, 178
converting, 56–58, 179
deleting, 49, 179
aperture priority mode, 80
aperture settings, 75–76
appropriation, 144
Archer, Frederick Scott, 137

Archive of Unnamed Women
project, 83
Arnheim, Rudolf, 43, 44, 250
Artboard tool, 53, 54
artboards
duplicating, 53, 54, 201
features of Illustrator, 14
setting up in XD, 200–202
Artist’s Mouse, The (DeLappe), 7
ascenders, letterform, 217
Atkins, Anna, 93, 138
audio clips/tracks, 290
Azzarella, Josh, 147

B
background
distinguishing foreground
and, 9–10
gradient added to, 36–38
swapping color of foreground
and, 162, 189
backward compatibility, 41
Barthes, Roland, 46, 139, 221
baseline, 206, 217
Bass Ale logo, 46
Batch Rename tool, 85–88
Bayard, Hippolyte, 138
Beck, Harry, 249, 251
Being Digital (Negroponte), 3
Bezier handles
contour tracing and, 166, 173–174
modifying paths and, 177–179
repositioning, 56–58
vector curves and, 46
Bierut, Michael, 250
binary relationships, 44
bitmap graphics, 12
bits, 6
Black & White adjustment layer, 192
black-and-white photos
applying color to, 132
film processing of, 66
Blank, Harrod, 69
blemish removal, 151
blending modes, 126
boardstorming, 324–326, 327
bracketing technique, 78–79
Brady, Mathew, 82, 83
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brand guidelines, 313
Braque, Georges, 144
Breton, André, 142
Bridge, 71, 82–90
batch renaming in, 85–88
PDF showcase generated
in, 88–90
using the workspace in, 82–85
Bringhurst, Robert, 254
Brush tool, 162–164, 189, 240
brushes
appearance settings, 157
sizing/resizing, 151, 189
brushwork texture, 316
Buñuel, Luis, 142
Burn tool, 157, 158, 192
burning and dodging, 155–156
buttons in prototypes, 207, 210

C
Cairns, Jonathan, 169
camera obscura, 62, 63
Camera Van (Blank), 69
cameras. See digital cameras
Canvas in Bridge, 88
Canvas Size dialog box, 101
cap height of letters, 217
Capture, Adobe, 135
Character panel, 232, 233, 235,
256, 269
Chicago Manual of Style, 257
circles
copying, 17–18
drawing, 16
clients
coping with difficult, 324
open communication with, 311
clipping layers, 192
clipping masks, 247
Clone mode, Spot Removal tool, 151
Clone Stamp tool, 146, 160–161
CMYK color mode, 114, 230
Cole, Tracey, 76
collages
copying/pasting to, 187, 190
examples illustrating, 167, 169
historical development of,
139–141

Lab challenge on creating, 193
Magic Wand tool used for,
186–188
modifying paths for, 177–179
moving images into, 185–186
steps for creating, 172–193
tracing image contours for,
172–176
workspace setup for, 170–172
color
additive, 113–117
applying to B&W photos, 132
CMYK mode of, 114, 230
comparison of, 127
correction process, 127–135
film processing, 66
harmony of, 118–122
inverting, 125
overview of, 111
primary and complementary,
114–115
RGB mode of, 113–114, 230
simultaneous contrast in, 117,
123–126
as subject of art, 116
subtractive, 112
swapping foreground/
background, 162, 189
text or type changes, 269, 270
warm and cool, 117
Color blending mode, 126
color cast removal, 295–296
color correction, 127–135
adjustment layers for, 128–131
Lightroom Classic for, 132–135
Color Guide panel, 50
Color panel, 17, 38, 40, 115, 269
Color Picker dialog box, 124
Colorize option, 120, 122, 183
combination printing, 138
combining shapes, 50–53
communication, clear and open, 311
complementary colors, 113, 114, 115
compression settings, 74
contact sheets, 88
Content panel in Bridge, 84, 85
continuity, law of, 278
contrast
simultaneous, 117, 123–126
typographical, 224–226, 255

Convert Anchor Point tool, 56,
57, 166
Convert Point tool, 179
Convert Project dialog box, 283
cool vs. warm hues, 117
copying/pasting
images, 102, 187
selections, 103, 104, 156, 158
shapes, 17–18, 51, 52
copyright law, 143–144
Craighead, Alison, 68
Creative Commons licenses, 143, 149
Crespo, riCardo, 317–318
Crop tool, 81–82, 106–107
Cullen, D. Myles, 24
Cult of Done Manifesto (Pettis &
Stark), 309–310, 327
curves
converting lines into, 56–58
creating with Pen tool, 166–167
Curves adjustment layer, 129–131
Cutaneous Habitats: Shiver
(Ludwig), 24, 26

D
da Vinci, Leonardo, 63
Dadaists, 139–141
Dalí, Salvador, 142, 170, 171
Decoding Design (Macnab), 24
deconstruction movement, 141
DeLappe, Joseph, 7
Delete Anchor Point tool, 49
deleting
anchor points, 49, 179
cropped pixels, 82
guides, 48
parts of selections, 157
video clips, 292–293
Demers, Michael, 318–320, 327
Demirjian, Andrew, 276, 278
depth, creating, 38–41
depth of field, 76
derivative works, 143
descenders, letterform, 217
Design mode, Adobe XD, 201
Design Thinking process, 199
digital cameras
light meters in, 70

mechanics of using, 72–73
settings on, 73–78
digital manipulation. See
manipulation of photos
digital photography
bracketing technique in, 78–79
Bridge program and, 71, 82–88
camera operation for, 72–78
light measurement in, 70
manipulation processes in,
142, 147
pixel-based images in, 65
post-production in, 66
preparing for, 79–80
rule of thirds in, 70–71, 80–82
zone system and, 95–96
digital video
adjusting clips in, 290–293
building composite sequences
for, 287–290
effects added and shared
for, 293–297
exporting as media file, 306–307
fade transitions applied to,
305–306
keyframes used in, 299–302
playback shortcuts for, 286
terminology associated with,
280, 283
timecode and frame rates for, 279
tracks added to, 302–303
type overlays on, 279, 280,
297–299, 302–303
workspace for editing, 283–287
digitalart-design.com website, xi, xii
Dip to Black transition, 305–306
Direct Selection tool, 46, 49, 55,
58, 177
distributing dots, 20–21
documents
copying layers to open, 184–186
creating in Illustrator, 13–14,
47–50
dodging and burning, 155–156
Dondis, Donis A., viii, ix, x
dots, 4–6
alignment of, 19–20
distribution of, 20–21
patterns of, 9, 10, 17–19
Down Arrow key, 49
Doyle, Christopher, 310
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DPI (dots per inch), 97, 100
Drop Shadow effect, 241
Drum, Meredith, 4
Duchamp, Marcel, 144
duplicating
artboard, 53, 54
images, 34–35
dust spot removal, 154

E
Eames, Charles and Ray, 198, 199
editing
non-destructive, 146, 152, 168
video workspace for, 283–284
Edwards, Mark, 167
Effect Controls panel, 293–294, 295,
299–300
effects
drop shadow, 241
video, 293–297, 299, 300
Effects panel, 294, 295, 299, 305
Eggert, Alicia, 24, 25
Eisenstein, Sergei, 142
Elder Scrolls IV: Oblivion game,
318–320
Electric Company, The (TV series),
281, 282, 297
Elements of Typographic Style, The
(Bringhurst), 254
Ellipse tool, 14–15, 16
ellipses, drawing, 15
Elliptical Marquee tool, 123
Empty Words (Lehni & Rich),
224, 225
Eraser tool, 168
Essentials Classic workspace, 29, 47
Essentials (Default) workspace, 80
Eternity (Eggert & Fleming), 24, 25
ethical issues, 146, 147
Export One File dialog box, 154–155
exporting
repaired images, 154–155
video files, 306–307
exposure value, 78, 79
eyeball icon, 34, 36, 59, 159
Eyedropper tool, 58, 204
Ezer, Oded, 247

F
Facebook page for book, xi
fade transitions, 305–306
fair use doctrine, 143–144
faktura concept, 139
Farber, Sam, 197
Feather setting, 153
Felton, Nicholas, 276, 277
fidelity of prototypes, 199
figure and ground
explained, 9–10
“on” and “off” study, 22
with repeated dots, 17–19
file formats, 27, 41, 74
File Type Associations option, 84
files
master, 41
naming, 27
saving, 27, 42, 60–61
selecting, 86
sharing, 27, 42
Fill icon, 16, 37
fills, 15, 16, 37
flattening layers, 232
Flaxton, Terry, 65
Fleming, Mike, 24, 25
fonts
Adobe Fonts, 259, 260, 297–299
sizing/resizing, 234
See also typefaces
foreground
distinguishing background
and, 9–10
swapping color of background
and, 162, 189
Formosa, Daniel, 197
frames
adjusting, 244–246
creating, 242–244
frames per second (FPS), 279
Free Transform, 125, 183, 186, 191
f-stop, 70, 73, 76, 79, 80

G
Gestalt psychology, 9–10, 250, 252
eight essential laws of, 252
laws of similarity and continuity,
276–278
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multistability property, 10, 252
primary concept of, 250
Gilliam, Terry, 141
Goldin, Nan, 281
Gomez, L. Hernandez, 320
Google Doodles, 221
Gradient panel, 37–38
gradients, background, 36–38
grid
exercise on using, 270–271
explanatory overview of,
249–250
placing guides on, 266–270
Gropius, Walter, 93
grouping
alignment and, 19–21
layers, 184
shapes, 49, 52
guides
implied lines using, 278
placement of, 259–261, 266–270
rule-of-thirds, 81–82
unlocking, 48, 267
working with, 48
Gutenberg, Johannes, 216, 217
Gyre II (Jordan), 10, 11

H
halation, 117, 123–126
Hand tool, 151
harmony, color, 118–122
Heal mode, Spot Removal tool,
151, 154
Healing Brush tool, 146
Helvetica font, 220, 247
Helvetica Live! poster (Ezer), 247
hiding/showing guides, 48
Hill, Charles, 197
histogram, 93, 107–108
Histogram panel, 107–108
History panel, 158, 159
hoaxes, 147, 160–164
Höch, Hannah, 141
Hoekema, Jim, 198, 199
Homage to the Square (Albers), 116,
117, 121
Horizon (Thomson & Craighead), 68

Houde, Stephanie, 197
Hue/Saturation adjustment layer,
118–122, 183, 184
hues
adjusting, 120, 122
complementary, 113, 114, 115
definition of, 111
primary, 114, 115
warm and cool, 117
See also color
Hughes, Jack, 116
Human Interface Guidelines
(HIG), 203
Hustwit, Gary, 220

I
Illustrator, 12
file presets in, 13–14
layers in, 31–32
master format in, 41–42
saving files in, 27, 41
typography in, 222
Image Size dialog box, 92–93,
97–100, 171
images
copying/pasting, 102, 187
duplicating, 34–35
linking, 30
locking, 30–31
manipulating, 137–142
placing, 29–30
reflecting, 58–59
relinking, 231
rotating, 186
scaling, 183, 186
tracing, 33, 172–176
type and, 221, 226, 239–242
implied lines, 278, 279
In and Out points, 284
In Re Ansel Adams (Flaxton), 65, 66
InDesign, Adobe, 222, 227
indexical signs, 46
Info panel, 104
inspiration, 281
integration prototypes, 197
inverting
colors, 125
layer masks, 188, 191
ISO settings, 74–75

italic type, 218
iterative processes, 288
Itten, Johannes, viii, 43, 44, 112, 117

J
James, Christopher, 94
Johnson, Chris, 95
Johnson, D. Wayne, 310
Jordan, Chris, 10, 11
Jovenville, 324–327
Jungmann, Aleš, 24, 28, 29
juxtaposition
apps for producing, 168
in collage creation, 167, 190

K
Kaiser, Kathleen, 311, 312, 313
“Kaleideolism” (2pxBorder), 44–45
Kane, John, 218, 219
kerning
derivation of word, 280
process of, 227–228, 229,
235–236, 239
rhythm of text controlled by, 255
KERNTYPE game, 236
keyframes, 299–302

L
Lab challenges
on collage creation, 193
on color correction, 135
on grid system, 273
on hoax creation, 164
on icon modification, 61
on letters expressed as
shapes, 22
on multimedia project
creation, 307
on pencil illustration of
movement, 42
on prototype creation, 212
on time passage theme, 90
on tonal range expansion, 110
on type–image relationship, 247
Lasso tool, 156
Lauer, David A., viii
Law of Prägnanz, 250, 252

layer masks
converting selections to, 181
fine-tuning, 189
fundamentals of, 168
inverting, 188, 191
layer thumbnails for, 181–182
situations for adding, 181
softening cloned edges with,
162–164
Layer Style dialog box, 123
layers
blending modes for, 126
clipping, 192
copying to open documents,
184–186
creating new, 32, 123
explanation of using, 31–32
flattening, 232
grouping in Layers panel, 184
naming/renaming, 105, 123, 157
scaling contents of, 183
stacking order of, 31, 105
Layers panel, 31, 103, 105–106,
158, 184
LCD screen vs. viewfinder, 72–73
Le, David, 77
leading
process of adjusting, 227,
228, 238
rhythm of text controlled by,
255, 256
virtual, 261–266
League of Imaginary Scientists,
320–323
Lee, Stan, 107
Lehni, Jürg, 224, 225
Lester, Paul Martin, 275
letter spacing, 227, 228, 255
letterforms, 216–220
Levels adjustment layer, 108–109,
128–129, 130
Library of Congress (LOC), 143, 149,
171, 216
Lichtenstein, Roy, 5
light
measuring, 70
time and, 67
light meters, 70
lightness, 111, 112
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Lightroom Classic
color correction in, 132–135
dust and blemish removal in,
149–155
lines, 6, 23–26
curves made from, 56–58
implied, 278, 279
length of text, 253–254
Pencil tool for creating, 32–34
tight vs. loose, 24
linking
images, 30
text boxes, 268
Lissitzky, El, 139
Live Corner widgets, 57
loaded graphics cursor, 29
locking
images, 30–31
transparency, 125–126
logo design, 11, 44, 46
Logo Design Love (Airey), 46
London Underground map,
249–250, 251
Lugwig, Colleen, 24, 26
luminosity, 111
Lupton, Ellen, 216, 217, 250, 252

measuring blocks, 261, 266, 267,
270, 273
See also virtual leading
Meggs, Philip, 221, 226
Méliès, Georges, 142
Metadata panel in Bridge, 84–85
Miedinger, Max, 220
Miller, J. Abbott, 250
Minus Front button, 53
misconceptions.net website, xi
Mission Hospital brochure, 312–314
mobile devices
designing for, 198
sharing prototypes on, 211
Moholy-Nagy, László, 93, 138
montage, film, 142
movable type, 216
Move tool, 103, 183, 185–186, 240
Müller-Brockmann, Josef, 253
multimedia projects, 307
multistability, 10, 252
mummy finger hoax, 160–164
Museum of Contemporary Art
(MOCA), 320–323
Myers, Tiffany, 117

M

N

MacKay, Mark, 236
Macnab, Maggie, 24
macOS platform, xi
Magic Wand tool, 186–188
Majoor, Martin, 218
manipulation of photos, 137–142
digital tools for, 142
ethics related to, 146, 147
hoaxes created through, 147,
160–164
photomontage and collage as,
139–141
surrealism as, 142
Mann, Sally, 281
markers, video, 288–289
marqueeing process, 15
master files, 41
Master of Photography website, 66
Mattel packaging revision, 317
McCarty, Kevin, 94
measurement units, 14

naming/renaming
artboard, 53, 54
batch process for, 85–88
files, 27
layers, 105, 123, 157
NASA images, 187
negative space, 20, 228, 258, 259, 261
Negroponte, Nicholas, 3–4, 6, 7
Nelson, Richard, 117
New Document dialog box, 13–14, 47
New Typography, The
(Tschichold), 253
Nexus Principle, 218
Nicéphore, Niépce, 136, 137
non-destructive editing, 146, 152, 168

O
online content, xi–xii
Opacity setting, 153, 246
operating systems, xi
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Orozco, Joven, 324
orphans, typographic, 257
Orton, Peter, 254
out-of-gamut warning, 124
Output Settings panel, 89, 90
Output workspace, 88
overflow text, 268, 269
Oyster City game, 4, 5

P
Paintbrush tool, 39
Palmer, Alfred T., 97
paper size, 258–259
paragraphs, assembling type into,
253–257
Pathfinder panel, 47, 52–53
paths, 16
converting, 180
copying, 17, 18
curved, 56–58, 166
modifying, 58, 177–179
stacking order of, 50
straight, 46
Paths panel, 176, 180
Patrick, Bryan, 142
pattern brush, 19
PDF files
generating to showcase images,
88–90
saving images as, 27, 42, 60–61
trim marks on, 60, 61, 272–273
peachpit.com website, xii
Pen tool
modifying paths with, 58
precision selecting with, 166–167
tracing images with, 172–176
Pencil tool, 32–34
Pencilbox Studios, 311–316
Mission Hospital brochure,
312–314
Perception of the Princess
project, 315–316
Pentak, Stephen, viii
Perception of the Princess project,
315–316
Pettis, Bre, 309
photogram, 93, 138
Photographs of British Algae
(Atkins), 93

photography
color vs. B&W, 66
historical development of, 63
manipulation processes in,
137–142
vector illustration vs., 64
zone system of, 65, 95–96, 103
See also digital photography
Photography workspace, 173
photomontage. See collages
Photoshop, 12
color correction in, 128–131
repairing photos in, 146, 155–159
Piana, Brian, 116
Picasso, Pablo, 144
pixels
bitmap images and, 12, 65
development of, 4, 6
redistributing, 92, 97–98
resampling, 92–93, 98, 99–100
pointillism, 5, 6
Polygon tool, 49
Polygonal Lasso tool, 119, 120
PPI (pixels per inch), 97, 99, 100
Practical Zone System for Film
and Digital Photography, The
(Johnson), 95, 96
Prägnanz, Law of, 250, 252, 300
Premiere Pro
Effect Controls panel, 293–294,
295, 299–300
Source and Program panels,
285, 293
Timeline panel, 285, 289, 291
title safe area, 280
video playback shortcuts, 286
workspace navigation, 283–287
See also digital video
primary colors, 114, 115
printing
combination, 138
paper size for, 258–259
resolution for, 97–98
trim marks for, 61, 272–273
Program panel, 285, 286
Project panel, 283, 284, 293
Properties panel, 108, 109
Prototype mode, Adobe XD, 207
prototypes
artboard setup for, 200–203
articulating the design of, 199

connecting the screens in,
207–210
designing the elements of,
204–206
explanatory overview of, 195–197
testing and sharing, 211
PSD files, 102
public domain images, 143, 149, 187
punk movement, 141

Q
Quick Develop panel, 133–134
Quick Selection tool, 190

R
Ray, Man, 93, 138
Rectangle tool, 34, 242
Rectangular Marquee tool, 103,
119, 183
redistributing pixels, 92, 97–98
Reflect tool, 58–59, 244
Rejlander, Oscar Gustav, 138
relinking images, 231
renaming. See naming/renaming
repairing photos
blemish and wrinkle removal,
149–155
Clone Stamp tool for, 160–161
Photoshop tools overview
for, 146
softening cloned edges, 162–164
tonal repairs, 155–159
resampling pixels, 92–93, 98, 99–100
resetting the workspace, 13, 30
resizing. See sizing/resizing
resolution
print, 97–98
prototype, 199
redistributing pixels for, 92,
97–98
resampling pixels for, 92–93,
99–100
screen, 99–100, 198
Responsive Resize option, 200
revision practices, 309–327
examples illustrating, 311–327
open communication related
to, 311
overview and manifesto on,
309–310, 327

RGB color mode, 113–114, 230
rhythm, typographical, 224–226, 255
Rich, Alex, 224, 225
Robinson, Henry Peach, 138
Rodchenko, Aleksander, 139, 141
Roe Seafood logo, 10, 11
Romain, Ron, 44, 45
rotating
images, 186
text boxes, 237
Rubin’s vase, 10
Ruder, Emil, 254
rule of thirds, 70–71, 80–82
rulers, 48, 183, 261

S
saccadic movements, 253–254
sans serif typefaces, 219–220
saturation
adjusting, 122
definition of, 111
Save Adobe PDF dialog box, 60, 272
saving files, 27, 42, 60–61, 272–273
Scale dialog box, 262, 263
scaling
dots, 18
images, 183, 186
selections, 121
video clips, 294
scanogram, 94
Schad, Christian, 138
screen resolution, 99–100, 198
screencasts, xii
on adding/deleting within
selections, 157
on clipping masks, 247
on collage process, 193
on colorizing B&W photos, 132
on editing digital video, 287
on grid use, 270
on horizon line effect, 39
on Info panel, 104
on keyframes, 303
on modifying paths, 58
on pattern brush, 19
on Premiere Pro projects, 283
on renaming files in Bridge, 88
on tracing with the Pen tool, 172
scrubbing video, 286
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selection column, 35, 36
Selection tool, 15, 16, 33, 233
selections
adding/deleting within, 157
consistency of, 105
converting paths to, 180–181
copying/pasting, 103, 104,
156, 158
features of tools for, 125
layer masks from, 181
making free-form, 156
marqueeing, 15
Pen tool for, 166–167
scaling, 121
sentences, assembling type into,
253–257
sequences
building composite, 287–290
video terminology for, 283
serif typefaces, 219–220
serifs, letterform, 217
Seurat, Georges, 5, 6
shadows
adding beneath images, 192, 193
Drop Shadow effect, 241
Shape Builder tool, 52
shapes, 14
aligning, 49
combining, 50–53
copying, 17–18, 51, 52
distributing, 20–21
drawing, 15, 16
framing with, 242–244
modifying, 54–55
reflecting, 58–59
selecting, 15, 16
stroke and fill of, 14, 16
three basic, 43–44
transforming, 125
sharing
files, 27, 42
prototypes, 211
Shift key, 16
shutter speed, 70, 77
shutter speed priority mode, 80
Signac, Paul, 5
signs and logos, 46
similarity, law of, 276
Simon, Scott, 310
simultaneous contrast, 117, 123–126

sizing/resizing
brushes, 151, 189
text boxes, 268, 269
type, 234–236
Sketchpad, 6
Sky Is Falling, The (Demers), 318–320
Smart Guides, 48
Snap command, 107
Solomon, Lucy Hg, 320
Sontag, Susan, 139
Soucy, Kyle, 211
Source panel, 285, 293
Spiekermann, Erik, 224, 250, 311
Spot Healing Brush tool, 146, 158
Spot Removal tool, 150–154
stacking order
of layers, 31, 105
of paths, 50
Stamberg, Susan, 5
standing meetings, 317–318
Stark, Kio, 309
Starry Night, The (van Gogh), 10, 11
Stevens, Rachel, 4
storyboard planning, 315
Stowell, Davin, 197
straight paths, 46
Stroke icon, 16
strokes
lines as, 6
of shapes, 14, 16
stylistic consistency, 275
subtractive processes, 112
surrealism, 142
Sutherland, Ivan, 6
SWEAT collective, 195, 196
Swiss International Style, 249,
252–253
symbolic signs, 46

T
Talbot, William Henry Fox, 137
Template button, 30
Terror, Diogo, 253
testing prototypes, 211
text
changing the color of, 269, 270
kerning, leading, and tracking,
227–229
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overflow indicator for, 268, 269
spacing considerations for,
255–256
widows and orphans in, 257
See also typography
text boxes, 227
adding, 232–233
linking, 268
resizing, 268, 269
rotating, 237
text frames, 227
Thinking with Type (Lupton), 216,
217, 252
third-party images, xiii
Thompson, Bill, 311, 312, 315–316
Thompson, Lauren, 76
Thomson, Jon, 68
time passage theme, 67–68, 90
timecode, 279, 284
timeline
adjusting clips in, 290–293
repositioning clips on, 289
video terminology for, 283
Timeline panel, 285, 289, 291
Tingley, Ashley, 77
title safe area, 280
Toews, Phoenix, 4
tonal range
color and, 113
modifying, 106–109
repairing, 155–159
values and, 93–95
Tool Overlay options, 154
tools, toggling between, 16
tracing images, 33, 172–176
tracking type
process of, 227, 228, 229
rhythm of text controlled by,
255, 256
tracks, audio/video, 290, 302–303
transforming shapes, 125
transitions
prototype, 207–209
video, 305–306
transparency
locking, 125–126
of type, 237
triggers, prototype, 207, 209
trim marks on PDFs, 60–61, 272–273

Tschichold, Jan, 253
Type and Image (Meggs), 221
Type Primer, A (Kane), 218
Type tool, 227
entering headlines with, 259
selecting text with, 232, 234
text boxes drawn with, 232, 233
typefaces
families of, 221
serif vs. sans serif, 219–220
See also fonts
Typographie (Ruder), 254
typography
alignment in, 254–255
classes of type in, 218–219
contrast and rhythm in,
224–226, 255
grid used in, 221, 249, 259–261,
266–271
guide placement for, 259–261,
266–270
Illustrator vs. InDesign, 222
images related to, 221, 226,
239–242
kerning in, 227–228, 229, 235–236,
239, 255
leading in, 227, 228, 238, 255, 256
letterforms in, 216–220
line length in, 253–254
overview of, 215–216
resizing type in, 234–236
resources about, 216
sentences and paragraphs in,
253–257
Swiss International Style of, 249,
252–253
tracking in, 227, 228, 229, 255, 256
video overlays using, 279, 280,
297–299, 302–303
virtual leading in, 261–266
widows and orphans in, 257
Tzara, Tristan, 139

U
Undo command, 173
units of measurement, 14
unlocking
guides, 48, 267
images, 34
user flow diagram, 199
user interface (UI)
designs, 142
kits, 203

V
values
contrasting, 38–41
histogram for reading, 93
zone system of, 95–96
Van Deusen, Thomas, 75
van Gogh, Vincent, 10, 11, 114
Varis, Lee, 101
vector graphics, 12, 64
verisimilitude, 144
video. See digital video
video tutorials. See screencasts
viewfinder vs. LCD screen, 72–73
viewport resolution, 198
Villareal, Leo, 2, 5, 10
virtual leading, 261–266
creating your own, 261–264
exercise on using, 264–266
visibility, issue of, 59
Visual Communication (Lester), 275

W

web resources, xi–xii
Wegman, William, 281
Wertheimer, Max, 250
white balance settings, 75
Widener, Jeff, 147
widows, typographic, 257
Wikimedia Commons, 143, 149
Willows, Simon, 144
Windows platform, xi
Wolcott, Alexander, 137
Wong, Wucius, viii
work files, xi
workspace
collage, 170–172
Essentials Classic, 29, 47
Essentials (Default), 80
Output, 88
Photography, 173
Premiere Pro, 283–287
resetting, 13, 30
wrinkle removal, 152–153

X
XD program. See Adobe XD
x-height of letters, 217

Z
Zellen, Jody, 279
zone system
analyzing photos using, 101–106
explanation of, 65, 95–96, 103
Zoom tool, 53, 120, 151
zooming in/out, 120

Warhol, Andy, 144
Wark, McKenzie, 139, 140
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